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Overview of TRANSLATE 
 

About Theorem 
 

 
Theorem Solutions is a world leader in the field of Engineering Data Services and Solutions. This leadership 
position stems from the quality of our technology and the people in the company. Quality comes not only from 
the skills and commitment of our staff, but also from the vigorous industrial use of our technology & services 
by world leading customers.  
 
We are proud that the vast majority of the world's leading Automotive, Aerospace, Defense, Power 
Generation and Transportation companies and their Supply chains use our products and services daily. 
Working closely with our customers, to both fully understand their requirements and feed their input into our 
development processes has significantly contributed to our technology and industry knowledge.  
 
Theorem Solutions is an independent UK headquartered company incorporated in 1990, with sales and 
support offices in the UK and USA. Theorem has strong relationships with the major CAD and PLM vendors, 
including; Autodesk, Dassault Systemes, ICEM Technologies (a Dassault company), PTC, SolidWorks, Spatial 
Technology and Siemens PLM Software. These relationships enable us to deliver best in class services and 
solutions to engineering companies worldwide.  
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Theorem’s Product Suite 
Theorem have 3 main Product brands. These are: 

 
 
 
 
 
 
 
 
 

  

 

CADTranslate 
 
Direct translation of 3D data to or from an alternate CAD, 
Visualization or Standards Based format. 
 
 
See our website for more detail. 

 
 

 

  

 
 

CADPublish 
 
The creation of documents enriched with 3D content 
 
 
 
See our website for more detail. 
 

  
  

 

TheoremXR 
 
Visualization for Augmented (AR), Mixed (MR) and Virtual (VR) 
Reality applications 
 
 
See our website for more detail. 
 

  

https://www.theorem.com/translate
https://www.theorem.com/cadpublish
https://www.theorem.com/extended-reality/augmented-reality
https://www.theorem.com/extended-reality/mixed-reality
https://www.theorem.com/extended-reality/virtual-reality
https://www.theorem.com/theorem-xr
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Primary Product Features 

• CADverter converts all geometry 

 
• If assembly data (product structure) is in the file, the assembly structure will be mapped 

between the two systems as well as colour information 

 
• The user can filter data to optimize the process 

 
• Command line interface allows process integration 

 

 
 
 

The CATIA V5 Bi-directional NX Translator 

Theorem’s CADverter product for CATIA V5 to NX is a direct database converter between Dassault 
Systemes CATIA V5 and Siemens NX. It enables the user to convert all forms of mechanical design 
geometry, as well as assembly and attribute information, between these two systems. 
 
The CATIA V5-NX CADverter product can be purchased as a uni-directional, CATIA V5 to Siemens NX, 
or Siemens NX to CATIA V5 product, or as a bi-directional product. It can be used interactively or in a 
batch mode, from a standard GUI Interface, offering combined viewing, data filtering and translation 
capabilities. 
 
The CADverter directly accesses native CATIA V5 parts, assemblies and drawing files using the 
Dassault Systemes supported programming interface. Assembly structure details and geometry 
colour information is retained during translation.  
 
The Adapter may be installed on a number of machines each accessing a central network-floating 
license. 
 

Primary Product Features 

• Converts all types of geometry, wire frame, surfaces, trimmed surfaces (faces) and solid 
models 

• Converts assembly structure between the systems 

• Converts attribute data including colour and layer information 

• The conversion process can be run Interactively or in Batch mode 

• Data can be filtered by layer and entity type 
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• Geometry can be filtered and selectively processed 

 

Primary Product benefits? 

• Direct conversion between CATIA V5 and NX reduces processing time, simplifies integration 
and retains accuracy of the model 

• The integrated viewing capability enables visually verification, pre and post translation 

• The integrated data filtering options allows selected data ONLY to be processed, enabling 
optimisation of translations and time savings 

• By converting all forms of geometry no data is lost, eliminating the time required to recreate 
missing data 

• With over 20 years industrial use Theorem’s product robustness and quality is well proven, 
reducing your business risk  

 

This document will focus specifically on guidance for the use of the CADverter for CATIA V5 – NX 
product.  For information regarding any of Theorem’s product ranges please contact 
sales@theorem.com 
 

  

mailto:sales@theorem.com
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Getting Started 

Documentation & Installation Media 
The latest copy of the User Guide documentation can be found on our web site at: 

http://www.theorem.com/Documentation 
 

Each product has a specific link that provides user documentation in the form of PDF and Tutorials. 
 
The latest copy of Theorem software can be found via the link above and by searching for the 
specific product. Each product has a specific link to the Product Release Document, which contains a 
link to the download location of the installation CD. 
 
Alternatively, you can request a copy of the software to be shipped on a physical CD. 
 
 

Installation 
The installation is run from the .msi file download provided. For full details of the installation 
process, visit www.theorem.com/documentation and select UI from the product selection list. 

 

License Configuration 
To run any product a valid license file is required. The Flex License Manager is run from the .msi file 
download provided. For full details of the installation process, visit 
www.theorem.com/documentation  

 

Using the Product 
To use the product, follow the documented steps found in this document or follow the online video 
tutorials which can be found from www.theorem.com/documentation 

 

  

http://www.theorem.com/Documentation
http://www.theorem.com/documentation
http://www.theorem.com/documentation
http://www.theorem.com/documentation
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Running the Product 
Once configured and licensed, the product is ready to be run. 

Prior to running the product CATIA V5 must have been started at least once to allow CATIA V5 
licenses to be accessed.  All specific CATIA V5 environment configuration details are documented in 
Appendix A of this document. 

There are 4 distinct ways of running the translator:  

• Via the Theorem Unified Interface 

o The Unified Interface offers a Desktop Environment that allows CAD and 
Visualization data to be viewed pre and post translation 

• Via the Command Line 

o The Command Line Interface provides a direct method of invoking the translator.  
It can be used via a DOS shell or called via a third party application as part of a 
wider process requirement. 

• Interactively from within CATIA V5 

o The Interactive Interface provides a direct method of Translating CATIA V5 data 
to and from NX from within CATIA V5 itself. 

• Interactively from within NX 

o The Interactive Interface provides a direct method of Translating NX data to and 
from CATIA V5 from within NX itself. 
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Using the Product 

Default Translations 
Default Translation – via the Unified Interface 
The Unified Interface can be started via the Start Menu – if a shortcut was added during installation. 

Alternatively, the Unified Interface can be run via a Windows Explorer selection in: 

<UI_installation_directory>\bin\Unified_Interface.cmd 

The following interface will be launched: 

The default layout is split into 4 primary areas, which can be altered to the users prefer: 

 

The simplest way to translate from CATIA V5 or NX is to drag a file from the file Browser Pane on to 
the Active Configurations for the translation you require.   

  

File 
Browser 

Active 
Configurations 

C 

Output 
Logs 

Translation 
Activity 
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On completion, the Unified Interface will display the activity information and details from the log file 
created during the translation, if requested, in the Translation Activity and Output Log panes, 
respectively. 

The generated output data can be located by selecting the translation from the Activity pane and 
opening the output folder: 
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Default Translation – via the Command Line 
Running a translation via the command line can be carried out via the cad_run.cmd file located in 
the <installation_directory>\bin directory. The format of the command is as follows when 
translating from CATIA V5 to NX: 

<Translator_installation_directory>\bin\cad_run.cmd CATIA5[XX]_NX[XX] –I <input_file> -o 
<output_file> 

The format of the command is as follows when translating from NX to CATIA V5: 

<Translator_installation_directory>\bin\cad_run.cmd NX[XX]_CATIA5[XX] –I <input_file> -o 
<output_file> 

(Note! Replace the [XX] seen in the example with the version of CATIA V5 or NX you are using. E.g. 
for CATIA V5 R33, change to CATIA533 and for NX 2212 change to NX2212): 
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The example above will translate a CATIA V5 sample file provided within the installation and produce 
the following screen output: 

 

 

 

 

 

The file will be output to the target location.  In this case: 

C:\Temp\nist_ctc_05_asme1_ct5210_rd.prt 
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CADverter Customization 

CADverter allows the information that is read from the source system and written to the target 
system to be tailored via a set of user specified arguments.  Commonly used arguments are 
supported via the Unified Interface, with Advanced Arguments being described within this document 
for use in the Unified Interface or via the Command Line invocation. 

Common Options for CATIA V5 to NX 
Within the Configuration Manager pane of the Unified Interface, arguments that can be specified 
when publishing CATIA V5 data into NX are grouped into 4 areas: 

• CATIA V5 Read  – Those arguments that affect how data is read from CATIA V5 

• NX Write   – Those arguments that affect how the data is written to NX 

• Entity Mask        – Those arguments that allow specific read entities to be masked 

• General  – Those arguments that are common to ALL Publishing activities 

    regardless of source data 
 

CATIA V5 Read Arguments 
The image below shows the CATIA V5 Read arguments that are available, with their default settings: 
 

 
 
Each of these options is described below: 

Option Description 

Retain 
Assembly 
Structure 

Enables Assembly Structure to be retain (Default is On) 
Disabling this option will remove all assembly structure and collapse ALL geometry 
into a single selectable object 

o Command Line Syntax: 

 off_ditto – to turn off 
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Read PMI Enables PMI data read from the V5 file. (Default is ON). 
o Command Line Syntax: 

 dont_read_pmi – to turn off 

 
Note! When ‘read_pmi’ is enabled it also enables the ‘fill_pmi_arrows’, 
‘fill_pmi_text’  and ‘pmi_filled_text’ options.  These can be overridden by setting 
the Advanced arguments: ‘dont_fill_pmi_arrows’ and/or ‘dont_fill_pmi_text’ 

PMI Level A secondary argument to ‘Read PMI’ and allows control of the level of PMI to be 
read. Default is ALL when ‘Read PMI’ is marked as ON. 

• Options Available (command line syntax in italics and square brackets next 
to the option) 

o All - [read_pmi] 

o Part Level - [read_part_pmi] 

o Assembly Level - [read_assy_pmi] 

o Assembly Set (From CATPart) - [read_part_assy_pmi] 

o Assembly Set (All) - [read_all_assy_pmi] 

 
Read 
Captures 

A secondary argument to ‘Read PMI’ and allows the control over whether captures 
are read as part of the process. Default is ON when ‘Read PMI’ is marked as ON. 

o Command Line Syntax: 

 read_captures 

 dont_read_captures – to turn off 

 
Read FTA 
Reference 
Geometry 

Enables reading of FTA Reference Geometry (Default is Off) 
o Command Line Syntax: 

 read_geometry – to turn on 

Maintain 
CATIA V5 
Instance 
Names 

Honours CATIA V5 Tools->Options->Infrastructure->Product Structure->Nodes 
Customization panel settings (Default is Off) 
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o Command Line Syntax: 

 ditto_naming V5 – to turn on 

Read Face 
Colours 

Processing geometry colours by face: 

o Command Line Syntax: 

 face_colour 

 solid_colour – to complete the opposite 

 
Read Face 
Opacity 

Processing face opacity: 

o Command Line Syntax: 

 Face_opacity – to turn on 

 
 
 
NX Write Arguments 
The image below shows the Write NX arguments that are available, with their default settings: 
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Each of these options is described below:  
 

Option Description 

Delete Existing Sub-parts Delete existing sub-parts. Default is OFF. 
o Command Line Syntax 

 delete_parts 

Concatenate Assembly Name Concatenates assembly name. Default is OFF. 
o Command Line Syntax 

 concat_assy 

Produce Tessellated Output Produce Tessellated NX file. Default is OFF. 
o Command Line Syntax 

 tess_output – to turn on 
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CATIA V5 to NX Entity Masking Arguments 
The image below shows the Masking arguments that are available, with their default settings: 

 

 

Each of these options is described below:  

Option Description 

Mask File 

 

Specifies the Mask File to be written to, that can be referenced 
by future translations.  A Mask file MUST be specified if masking 
is required.  The first line in this file is OFF ALL ENT: 

o Command Line Syntax: 

 Mask <filename> 

Entity Types Translated Specifies a selection list from which to select which entity types 
are to be processed.  The following types are available: 
"POI","CUR",”SKI”,"SOL",”ISO”,"TEX","AXI" 

o Command Line Syntax: 

 Add any of the above to the specified 
mask file, one entry per line prefixed by 
the word ON, e.g.: 

ON POI 
to ensure they are considered in the 
translation 

Layers Translated Specifies a selection list from which to select which layers are to 
be processed.  

o Command Line Syntax: 

 A single entry of ON ALL LAY Must 
precede any Layer Mask command. 
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 Add a list or range of numbers 
representing layer to be processed to the 
specified mask file to ensure they are 
NOT considered in the translation 

e.g.: 
OFF LAY 114,149,166,167,168 

Convert NO SHOW Geometry Enables Hidden geometry to be processed (Default = Off) 
o Command Line Syntax: 

 Add the following entry to the Mask file 

       ON NOSHOW 
Convert NO SHOW Structure Enables Hidden Assembly Structure to be processed (Default = 

Off) 
o Command Line Syntax: 

 Add the following entry to the Mask file 

                                           ON NOSHOW STR 
Convert NO SHOW PMI Enables Hidden PMI to be processed (Default = Off) 

o Command Line Syntax: 

 Add the following entry to the Mask file 

                                           ON NOSHOW PMI 
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CATIA V5 to NX General Arguments 
The image below shows the General arguments that are available, with their default settings: 
 

 

 

Each of these options is described below:  

Option Description 

Mass Properties 

 

Allows Mass Property information to be read from the source data and 
written as attributes to the PDF document. Default is OFF. 

o Command Line Syntax: 

 mprops 

Out-of-range 
Layers 

How to handle layers from the input system that are out-of-range in the 
output system. Default is ‘Map To Layer’ 

o Command Line Syntax: 

 Map To Layer: Default 

 Layer Modulus (Cycle): cycle_layer 

Layer Number A secondary option used with Out-of-range Layers when ‘Map To Layer’ is 
selected. Allows the layer number to be specified. Default is 256. 

o Command Line Syntax: 

 base_layer 256 

Advanced Allows any of the Command Line Advanced arguments documented below to 
be passed to the Unified Interface invocation 
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Common Options for NX to CATIA V5 
Within the Configuration Manager pane of the Unified Interface, arguments that can be specified 
when publishing CATIA V5 data into NX are grouped into 4 areas: 

• NX Read  – Those arguments that affect how data is read from CATIA V5 

• CATIA V5 Write  – Those arguments that affect how the data is written to NX 

• Entity Mask        – Those arguments that allow specific read entities to be masked 

• General  – Those arguments that are common to ALL Publishing activities 

    regardless of source data 
 

NX Read Arguments 
The image below shows the NX Read arguments that are available, with their default settings: 

 
 

 
 

Each of these options is described below. 
 

Option Description 

Reference Set Enabled reference set processing. Default is OFF 
o Command Line Syntax: 

 No_ref_set – to turn off 

Read NX Attributes Read NX detail user attributes. Default is OFF. 
o Command Line Syntax: 

read_attrs 
Read NX names Read NX entity names, if they exist. Default is OFF. 

o Command Line Syntax: 

 no_read_name – default 

 read_name – to turn on 
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Read PMI Read 3D PMI. Default is OFF. 
o Command Line Syntax: 

 read_pmi write_stroked_pmi 

 

 
 
CATIA V5 Write Arguments 
The image below shows the CATIA V5 Write arguments that are available, with their default settings: 
 
 

 
 

 
Each of these options is described below: 

Option Description 

Output Geometry 
File Type 

Output Geometry file type. Default is CATPart. 
o Command Line Syntax 

 CATPart: output_type CATPart 

 Model: output_type model 

 Cgr: output_type cgr 

 Igs: output_type igs 

 CATShape: output_type CATShape 

 Tessellated: create_cgr 

Write Face 
Colours 

Writes face colours. Default is ON. 
o Command Line Syntax 

 FACE_COLOUR 

 SOLID_COLOUR – to turn off 
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Show Reference 
Planes 

Creates reference planes. Default is OFF. 
o Command Line Syntax 

 Show: dont_blank_planes 

 No Show: Default 

Retain Assembly 
Structure 

Maintains the structure from the source file  
o Command Line Syntax 

 off_ditto 

 
Property 
Mapping File 

This mapping file is used to control which properties are exported from V5 to 
NX 

o Command Line Syntax 

 CAD_PROP_MAP_FILE <path_to_file> 

 Detail on map file structure below: 
 
Line Format:- 
  
 SourceName, TargetName, Control, Dummy, Dummy, Dummy 
     Control:- 
     0 - Do not convert 
     1 - Use the source values as given 
 
By setting the control value to 0 will stop a specific property  
 from being exported. Alternatively you can switch the property 
 name that is found in the input data to a different name in the 
 output file. This is performed by switching the name between the 
 input name = field 1 and the output name = field 2 
 
  Example settings shown with "#" comment for each line 
 
_ActivateBOM,NULL,0,,, 
_LastModifier,NULL,0,,, 
_Maturity,NULL,0,,, 
_PrdVersion,NULL,0,,, 

 
 

NX to CATIA V5 Entity Masking Arguments 
The image below shows the Masking arguments that are available, with their default settings: 
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Each of these options is described below: 

Option Description 

Mask File Specifies the Mask File to be written to, that can be referenced 
by future translations.  A Mask file MUST be specified if masking 
is required.  The first line in this file is OFF ALL ENT: 

o Command Line Syntax: 

 Mask <filename> 

Entity Types Translated Specifies a selection list from which to select which entity types 
are to be processed.  The following types are available: 
"POI","LIN","ARC","CON","CUR","SUR","FAC","SOL" 

o Command Line Syntax: 

 Add any of the above to the specified 
mask file, one entry per line prefixed by 
the word ON, e.g.: 

ON POI 
to ensure they are considered in the 
translation 

Layers Translated Specifies a selection list from which to select which layers are to 
be processed.  

o Command Line Syntax: 

 A single entry of ON ALL LAY Must 
precede any Layer Mask command. 

 Add a list or range of numbers 
representing layer to be processed to the 
specified mask file to ensure they are 
NOT considered in the translation 

e.g.: 
OFF LAY 114,149,166,167,168 
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NX to CATIA V5 General Arguments 
The image below shows the General arguments that are available, with their default settings: 

 

 

The option is described below: 

Option Description 

Advanced Allows any of the Command Line Advanced arguments to be 
passed to the Unified Interface invocation 
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Command Line Advanced Arguments  

Any of the Advanced arguments can be added to the Command Line Invocation or to the General-
>Advanced field when run from within the User Interface. 

NX Advanced Arguments 
Argument Description 

facet_solid_read 
create_facets 

Options to support the reading of scanned data  

 

CATIA V5 Advanced Arguments 
Argument Description 

convert_curves Converts curves to NURBS form 

convert_surfaces Converts surfaces to NURBS form 

dont_fill_pmi_arrows  Disables the read of filled arrow information (default for ‘read_pmi’) 

 dont_fill_pmi_text Disables the read of filled text information (default for ‘read_pmi’) 

 dont_read_captures Disables the read of PMI Capture information (default for ‘read_pmi’) 

face_opacity Read face opacity 

no_face_colour Sets the default to SOLID colours 

noshow 
noshow_geom 
noshow_struct 
noshow_pmi 

Reads hidden geometry / structure / pmi 

output_mbd Allows sub-part specification tree information to be read and 
presented to 3D PDF as product structure information.  This option 
also enables the ‘part_level_views’ and ‘part_level_pmi’ 3D PDF 
options 

read_geometry_edges CATIA V5 has a display mode that allows the display of shaded surfaces 
and edges. This option allows the translator to mimic this for FTA 
construction geometry by promoting the edge curves to standalone 
wireframe.  

SEPARATE_FSOLS_ON 
 

Support to process NX data that contains both solid and tessellated 
bodies (convergent model) to CATIA V5. The solid data is created as  a 
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CATPart and the tessellated data in a CGR file then an assembly file is 
created to hold them together.  

 

CATIA V5 – NX PDF Add On Products 

As an optional feature, the creation of 3D PDF documents can be added to the functionality of the 
CATIA V5 – NX license. 

This requires an additional software download and is documented within that download. Please 
contact sales@theorem.com for more information. 

Translating Interactively from within CATIA V5 

The CATIA V5 to NX translator allows an active CATIA V5 Part or Assembly to be translated directly 
into NX or an NX Part or assembly to be imported, directly from the CATIA V5 application. 

In order to translate from within CATIA V5, the CATIA V5 application must be started from within a 
Theorem environment, so that the appropriate CATIA V5 menus are loaded. 

CATIA V5 can be started from a shortcut, if requested at installation time.  Alternatively, it can be 
started via the script provided in the CADverter installation at: 

<installation_directory>\bin\catia5r[version]_start.cmd  

(where [version] should be substituted for the version of CATIA V5 that you have installed – e.g29, 
30, 31, 32 & 33): 

 
 
Theorem Export 
Once CATIA V5 has been started and a model loaded, the active Part or Assembly can be exported to 
NX. 

mailto:sales@theorem.com
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In order to export, the user selects the File -> Theorem Export Menu Option: 

 

 
 

Which in turn launches the Theorem Export panel: 
 

 
 
 

The Input CATIA V5 File Name, Output File Name and Progress File Name fields will be 
prepopulated if a model is already loaded into the CATIA V5 session.  However, these locations can 
all be modified prior to selecting the OK button. 
 
The Configure tab allows a configuration file to be given to the translation containing any additional 
arguments specified by the user. The options seen from within this configure panel will mirror those 
configurations created within the Theorem Unified Interface. Please see Page 8 of this document for 
details on using the Unified Interface. 
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On selecting OK the on the Export Panel the active Part or Assembly will be written to NX using the 
into the selected output directory. 

Theorem Import 
Once CATIA V5 has been started, NX data can be loaded into CATIA V5. 
 
In order to import, the user selects the File -> Theorem Import Menu Option: 

 

 
 

Which in turn launches the Theorem Import panel: 
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The Import From option allows the user to select the version of NX to import from. 
The Input File Name option allows the selection of a NX .prt file. The Output File Name and Progress 
File Name fields will be populated when a model is selected and will, by default, save the associated 
files in the same directory as the NX part. Import Geometry Format allows the choice of CATPart or 
CGR for the translation output. 
 
The Configure tab allows a configuration file to be given to the translation containing any additional 
arguments specified by the user. The options seen from within this configure panel will mirror those 
configurations created within the Theorem Unified Interface. Please see Page 8 of this document for 
details on using the Unified Interface. 
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On selecting OK the on the Import Panel the NX data will be imported into CATIA V5 and the data 
saved using the input into the selected output directory. 
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Translating Interactively from within NX 

The NX to CATIA V5 translator allows an active NX Part or Assembly to be translated directly into 
CATIA V5 or a CATIA V5 Part or assembly to be imported, directly from the NX application. 

In order to translate from within NX, the NX application must be started from within a Theorem 
environment, so that the appropriate NX menus are loaded. 

NX can be started from a desktop shortcut, if requested at installation time.  Alternatively, it can be 
started via the script provided in the CADverter installation at: 

<installation_directory>\bin\ RunNX[version].cmd 

(where [version] should be substituted for the version of CATIA V5 that you have installed – e.g. 
2007, 2206 & 2212): 
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Theorem Export 
Once NX has been started and a model loaded, the active Part or Assembly can be exported to CATIA 
V5. 
 
In order to export, the user selects the File -> Export Menu. There are then 2 Export options: 
 

• Theorem Interactive Export to CATIA RXX (As Saved) 

o This is for use with data saved on a file system 

• Theorem Interactive Export to CATIA RXX (TeamCenter Loaded) 

o This is for use with data loaded from TeamCenter 

 

 
 

Once an option is selected the Theorem Export panel opens: 
 

 
 
 

The Input File, Output File > Target Directory and Progress Log fields will be prepopulated if a 
model is already loaded into the NX session.  However, these locations can all be modified prior to 
selecting the OK button. 
 
The Configurations tab allows a configuration file to be given to the translation containing any 
additional arguments specified by the user. The options seen from within this configure panel will 
mirror those configurations created within the Theorem Unified Interface. Please see Page 8 of this 
document for details on using the Unified Interface. 
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On selecting OK the on the Export Panel the active Part or Assembly will be written to CATIA V5 
using the into the selected output directory. 

Theorem Import 
Once NX has been started and a new model opened, CATIA V5 data can be loaded into NX. 
 
In order to import, the user selects the File -> Import -> Theorem Interactive Import from CATIA5 
RXX Menu Option: 

 

 
 

Which in turn launches the Theorem Import panel: 
 

 

The Select CATIA5 RXX file for NX Import option allows the selection of a CATIA V5 part. The Target 
File and Progress Log fields will be populated when a model is selected and will, by default, save the 
associated files in the same directory as the V5 part.  
 
The Configurations tab allows a configuration file to be given to the translation containing any 
additional arguments specified by the user. The options seen from within this configure panel will 
mirror those configurations created within the Theorem Unified Interface. Please see Page 8 of this 
document for details on using the Unified Interface. 
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On selecting OK the on the Import Panel the NX data will be imported into CATIA V5 and the data 
saved using the input into the selected output directory. 
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Appendix A – CATIA V5 Configuration 

Introduction 
This Appendix details how to define and configure the CATIA V5 and Theorem environment to work 
together.  

Conventions 
Release of CATIA V5  
To indicate a release of CATIA V5 the notation <XX> shall be used. This needs to be replaced with the 
specific release to be used i.e.  29, 30, 31, 32 & 33 

Platform specific directory 
Within the installation directory of CATIA V5 there is a platform specific directory i.e. win_b64. This 
directory shall be referred to as <OSDS> in this Appendix. 

Theorem Installation directory 
The Theorem translator installation directory is set at installation time in the translator ts_env.bat 
file. This directory shall be noted as <%TS_INST%> in this Appendix. 

CATIA V5 Installation Directory  
Upon installation of a CATIA V5 product the user will be asked to specify the installation directory. 
This is the directory which contains the platform specific <OSDS> directory.  

Having selected the CATIA V5 installation directory via the browse button, the installation process 
will record the location of the CATIA V5 installation directory in the ts_env.bat file. This file is located 
in the Theorem translator installation directory. If the location of CATIA V5 subsequently changes, 
the translator can be guided to the changed location by modifying this file using a text editor to 
modify the ts_env.bat that is located in the translator installation directory. 
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Running CATIA V5 Translators  
Before running the translator the user must run CATIA V5 interactively at least once to configure the 
CATIA V5 environment and license settings. This can be achieved by running the catia5r<XX>_start 
script as follows: 

%TS_INST%\bin\catia5r<XX>_start.cmd 

Once CATIA has been run the Translator can run as described in the relevant product User Guide. 

CATIA V5 Environment DIRENV & ENV  
The default location for CATIA V5 to store its global environment files is in the global directory: 

Windows XP: 

C:\Documents and Settings\All Users\Application Data\DassaultSystemes\CATEnv 

Windows 7 & 8: 
C:\ProgramData\DassaultSystemes\CATEnv 

Or 
%APPDATA%\CATEnv  

You can find this location by running: 

%CATIAV5_INST%\<OSDS>\code\bin\setcatenv -h 

The environment files are named in the form CATIA.V5RN.B<XX>.txt 

If when installing CATIA V5 the default environment file location was replaced with another location 
then this location needs to be indicated to the CADverter by defining in the ts_env.bat the 
environment variable CATIAV5_DIRENV: 

set CATIAV5_DIRENV=/some/directory 

If the Theorem installation is needed to support multiple releases of CATIA. Then the user can define 
release specific locations using: 

set CATIAV5R<XX>_DIRENV=/some/directory 

The Theorem translator will attempts to create its own environment file called 
TheoremCatia5R<XX>.txt. The user must therefore have write permission to the CATEnv directory. If 
this is not possible an existing environment file can be specified using the variable CATIAV5_ENV. 
e.g.  

set CATIAV5_ENV=CATIA.V5R27.B27 

Note. the extension .txt is not required. The user can specify a release specific name using 
CATIAV5R<XX>_ENV e.g.  

set CATIAV5R19_ENV=CATIA.V5R27.B27 
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Checking the CATIA V5 Environment  
A script is provided to check that the CATIA V5 environment is set up correctly. In a command 
window run the command script: 

%TS_INST%\bin\checkcatia5r<XX>env.cmd 

Checking the Theorem Shared Library  
A script is provided to ensure that the CATIA V5 environment is compatible with the Theorem shared 
library.  In a command window run the command script: 

%TS_INST%\bin\checkcatia5r<XX>cadverter.cmd 

A successful output is an indication that the location for CATIA V5 has been specified to the Theorem 
translator correctly and that the correct version of the Theorem CATIA V5 translator products have 
been installed.  
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